
Excel Tutorial 2: Formatting Workbook Text and Data  

 
TRUE/FALSE 

 

 1. Formatting changes only the appearance of data—it does not affect the data itself. 

 

ANS: T PTS: 1 REF: EX 70 

 

 2. Changing the number of decimal places displayed in a cell does not change the value stored in the cell.  

 

ANS: T PTS: 1 REF: EX 84 

 

 3. After you merge a range into a single cell, you cannot realign its content.  

 

ANS: F PTS: 1 REF: EX 90 

 

 4. The Format Painter does not copy formatting applied to selected text within a cell, and it does not copy 

data. 

 

ANS: T PTS: 1 REF: EX 101 

 

 5. The appearance of non-theme fonts, colors, and effects remains unchanged no matter which theme is 

applied to the workbook.  

 

ANS: T PTS: 1 REF: EX 106 

 

 6. Conditional formats are dynamic, so a cell’s appearance will change to reflect its current value.  

 

ANS: T PTS: 1 REF: EX 108 

 

 7. A conditional format can make negative numbers red and positive numbers black.  

 

ANS: T PTS: 1 REF: EX 108 

 

 8. Page Break Preview identifies manual page breaks with a dotted blue line and automatic page breaks 

with a solid blue line. 

 

ANS: F PTS: 1 REF: EX 116 

 

 9. Each header and footer has three sections—a left section, a center section, and a right section. 

 

ANS: T PTS: 1 REF: EX 119 

 

 10. By default, Excel sets the page margins to 0.5 on the left and right margins and 0.75 on the top and 

bottom margin. 

 

ANS: F PTS: 1 REF: EX 121 

 
MODIFIED TRUE/FALSE 

 

 1. Excel organizes fonts into theme and non-theme fonts. _________________________  
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ANS: T   PTS: 1 REF: EX 71 

 

 2. The cell reference for the merged cell is the upper-right cell reference. _________________________ 

 

ANS: F, upper-left 

 

PTS: 1 REF: EX 90 

 

 3. By default, Excel displays text in a(n) black font color. _________________________ 

 

ANS: T   PTS: 1 REF: EX 73 

 

 4. The background image does not affect any cell’s format or content. _________________________ 

 

ANS: T   PTS: 1 REF: EX 77 

 

 5. Calculated values too large to fit into the cell are displayed in scientific notation. 

_________________________ 

 

ANS: T   PTS: 1 REF: EX 82 

 

 6. Text and numbers are displayed vertically within cells. _________________________ 

 

ANS: F, horizontally 

 

PTS: 1 REF: EX 91 

 

 7. A(n) theme is a collection of formatting options that include a specified font, font size, font styles, font 

color, fill color, and borders. _________________________ 

 

ANS: F, style 

 

PTS: 1 REF: EX 99 

 

 8. A(n) conditional format applies formatting to a cell when its value meets a specified condition. 

_________________________ 

 

ANS: T   PTS: 1 REF: EX 108 

 

 9. A(n) footer appears at the top of each printed page. _________________________  

 

ANS: F, header 

 

PTS: 1 REF: EX 119 

 

 10. If you want to print only part of a worksheet, you can set a(n) print area, which is the region of the 

worksheet that is sent to the printer. _________________________ 

 

ANS: T   PTS: 1 REF: EX 115 

 
MATCHING 

 

Match each of the following icons with the description that most closely matches its function. 



a. 
  

f.  

b. 
 

g.  

c. 
 

h. 
 

d. 
  

i. 
 

e. 
 

j. 
 

 

 

 1. Aligns the cell content with the cell’s bottom edge  

 

 2. Increases the size of the indentation used in the cell  

 

 3. Decreases the size of the indentation used in the cell  

 

 4. Vertically centers the cell content within the cell  

 

 5. Aligns the cell content with the cell’s top edge 

 

 6. Decreases the decimal place  

 

 7. Merges the selected cells into a single cell  

 

 8. Horizontally centers the cell content within the cell  

 

 9. Forces the cell text to wrap within the cell borders 

 

 10. Rotates the cell content to any angle within the cell  

 

 1. ANS: C PTS: 1 REF: EX 87 

 

 2. ANS: F PTS: 1 REF: EX 87 

 

 3. ANS: G PTS: 1 REF: EX 87 

 

 4. ANS: B PTS: 1 REF: EX 87 

 

 5. ANS: A PTS: 1 REF: EX 87 

 

 6. ANS: D PTS: 1 REF: EX 84 

 

 7. ANS: J PTS: 1 REF: EX 87 

 

 8. ANS: E PTS: 1 REF: EX 87 

 

 9. ANS: I PTS: 1 REF: EX 87 

 

 10. ANS: H PTS: 1 REF: EX 87 

 
MULTIPLE CHOICE 

 

 1. One of the benefits of Live Preview is that it _____. 

a. lets you see and evaluate different formats as you develop your workbook 

b. shows you what a document will look like when printed 

c. applies thematic styles to your document 

d. allows you to track changes in your document 
 

 

ANS: A PTS: 1 REF: EX 70 

 

 2. When you don’t want to associate a font with a particular design, you use a _____ font. 

a. theme c. sans serif 

b. serif d. non-theme 
 

 

ANS: D PTS: 1 REF: EX 71 

 

 3. Italic, bold, bold italic, and underline are examples of _____. 

a. font themes c. graphics 

b. font styles d. character settings 
 

 

ANS: B PTS: 1 REF: EX 71 

 



 

 

 4. In the accompanying figure, an example of a theme font is _____. 

a. Algerian c. Arial 

b. Calibri d. Batang 
 

 

ANS: B PTS: 1 REF: EX 72 

 

 5. In the accompanying figure, the font in Live Preview is _____. 

a. Algerian c. Arial 

b. Calibri d. Calibri Light 
 

 

ANS: A PTS: 1 REF: EX 72 

 

 6. In the accompanying figure, the _____ indicates the font is 11pt. 

a. Font arrow c. Font color 

b. Font size box d. Font graphic 
 

 

ANS: B PTS: 1 REF: EX 72 

 

 7. In the accompanying figure, it shows that _____ is the theme font used for headings. 

a. Algerian c. Cambria 

b. Batang d. Calibri Light 
 

 

ANS: D PTS: 1 REF: EX 72 

 

 8. In a workbook’s theme, _____ colors are designated for text and background, _____ colors are used 

for accents and highlights, and _____ colors are used for hyperlinks. 

a. Four, two, six c. Four, six, two 

b. Two, four, six d. Six, four, two 
 

 



ANS: C PTS: 1 REF: EX 73 

 

 9. To add a _____ to a sheet tab, right-click a sheet tab, point to Tab Color on the shortcut menu, and 

then click a color. 

a. fill color c. format color 

b. tab setting d. formatting style 
 

 

ANS: A PTS: 1 REF: EX 76 

 

 10. When creating an Excel document, you should avoid using _____ text and background together, since 

this is the most common form of color blindness. 

a. red and green c. black and white 

b. yellow and blue d. red and yellow 
 

 

ANS: A PTS: 1 REF: EX 76 

 

 11. By default, numbers appear in the _____ and generally display values exactly as you type them. 

a. Home tab c. General number toolbar 

b. General format d. currency format 
 

 

ANS: B PTS: 1 REF: EX 82 

 

 12. Because Excel stores dates and times as _____, you can apply different formats without affecting the 

date and time value. 

a. numbers c. universal numbers 

b. text d. Greenwich Mean Time 
 

 

ANS: A PTS: 1 REF: EX 86 

 

 13. In Excel, dates are _____-aligned in the cell by default, regardless of date format. 

a. right c. center 

b. left d. top 
 

 

ANS: A PTS: 1 REF: EX 87 

 

 14. As a general rule, you should _____. 

a. center column titles, left-align text, and right-align numbers 

b. center column titles, right-align text, and left-align numbers 

c. right-align column titles, left-align text, and right-align numbers 

d. left-align column titles, left-align text, and right-align numbers 
 

 

ANS: A PTS: 1 REF: EX 87 

 

 15. _____ merges each of the rows in the selected range across the columns in the range. 

a. Merge build c. Merge Across 

b. Merge and Center d. Merge Cells 
 

 

ANS: C PTS: 1 REF: EX 90 

 

 16. In Excel, to merge cells A1, B1, C1, D1, and E1, _____ is the correct reference for the merged cell. 

a. A1!E1! c. E1 

b. A1 d. A1-E1 
 

 

ANS: B PTS: 1 REF: EX 90 

 



 17. Options to rotate cells in Excel are available using the _____ button in the Alignment group on the 

Home tab. 

a. Format c. Sorter 

b. Orientation d. Alignment 
 

 

ANS: B PTS: 1 REF: EX 91 

 

 

 

 18. In the accompanying figure, the number 4 displays _____. 

a. alignment buttons 

b. indented text 

c. borders added above and below cell content 

d. centered text 
 

 

ANS: C PTS: 1 REF: EX 89 

 

 19. In the accompanying figure, the number 3 displays _____. 

a. alignment buttons c. indented text 

b. centered text d. left-aligned text 
 

 

ANS: C PTS: 1 REF: EX 89 

 

 20. In the accompanying figure, the number 1 displays _____. 

a. alignment buttons c. indented text 

b. centered text d. borders above and below cell content 
 

 

ANS: A PTS: 1 REF: EX 89 

 

 21. The Format Cells dialog box has six tabs, including _____. 

a. Decimals c. Border 

b. Security d. Shading 
 

 

ANS: C PTS: 1 REF: EX 93 

 



 22. In the Format Cells dialog box, the _____ tab allows you to format currency by choosing decimal 

places, comma separators, and regular number displays. 

a. Number c. Alignment 

b. Font d. Fill 
 

 

ANS: A PTS: 1 REF: EX 92 

 

 23. You can open the Format Cells dialog box by right-clicking a cell or selected range, and then clicking 

_____ on the shortcut menu. 

a. Format c. Format Cells 

b. Cells d. Cells Style 
 

 

ANS: C PTS: 1 REF: EX 93 

 

 24. When using the Format Painter, double-click the Format Painter button to paste the same format 

multiple times and click the Format Painter again to _____. 

a. turn it on c. copy formatting 

b. turn it off d. paste formatting 
 

 

ANS: B PTS: 1 REF: EX 101 

 

 25. Put the following five steps in the order in which you would perform them to use the Paste Special 

function. 

1. Select and copy a range. 

2. Click the Paste button arrow in the Clipboard group on the HOME Tab. 

3. Specify exactly what you want to paste.  

4. Click Paste Special to open the dialog box. 

5. Select the range where you want to paste the Clipboard contents. 

a. 1, 2, 4, 3, 5 c. 1, 5, 2, 4, 3 

b. 1, 2, 4, 5, 3 d. 1, 5, 2, 3, 4 
 

 

ANS: C PTS: 1 REF: EX 104 

 

 26. _____ are an example of conditional formats in Excel. 

a. Data bars c. Font sets 

b. Quick Analysis tools d. Percentages 
 

 

ANS: A PTS: 1 REF: EX 109 

 

 27. A _____ is the space between the page content and the edges of the page. 

a. margin c. frame 

b. border d. ruler 
 

 

ANS: A PTS: 1 REF: EX 121 

 

 28. One way to ensure that you are using consistent formats is to copy and paste your formats using the 

Format _____. 

a. Master c. Palette 

b. Gallery d. Painter 
 

 

ANS: D PTS: 1 REF: EX 101 

 

 29. In conditional formatting, to highlight only cells that contain a specific date, select the rule _____. 

a. A Date Occurring c. Text That Contains 

b. Duplicate Values d. Equal To 
 

 



ANS: A PTS: 1 REF: EX 109 

 

 30. Fonts, colors, and cell styles are organized in _____ categories. 

a. theme and non-theme c. color and black and white 

b. numbers and text d. form and function 
 

 

ANS: A PTS: 1 REF: EX 106 

 

 31. Setting the _____ to A1:L10 will print only data in those cells. 

a. Page Format c. Page Break 

b. Print Area d. Print Preview 
 

 

ANS: B PTS: 1 REF: EX 115 

 

 32. To avoid splitting a worksheet in awkward places, you can insert a _____ to specify a specific 

breaking point. 

a. page insert c. print area 

b. manual page break d. selection 
 

 

ANS: B PTS: 1 REF: EX 116 

 

 33. To set a page break in Excel, select the _____. 

a. first cell below the row where you want to insert a page break 

b. first cell above the row where you want to insert a page break 

c. row above where you want to insert a page break 

d. row below where you want to insert a page break 
 

 

ANS: A PTS: 1 REF: EX 116 

 

 34. A _____ indicates a manual page break. 

a. dashed blue line c. dashed red line 

b. solid blue line d. solid red line 
 

 

ANS: B PTS: 1 REF: EX 116 

 

 35. Information that prints on each page, like a company name or logo, may be set as a _____. 

a. print setup c. text header 

b. copied text d. print title 
 

 

ANS: D PTS: 1 REF: EX 117 

 

 36. The code _____ will display the filename of the current workbook. 

a. &name c. +name 

b. &[File] d. +[File] 
 

 

ANS: B PTS: 1 REF: EX 120 

 

 37. The header and footer sections include a _____. 

a. left and right section c. top and bottom section 

b. center section only d. left, right, and center section 
 

 

ANS: D PTS: 1 REF: EX 119 

 

 38. Header and footer elements such as worksheet name, current date, and time are _____ elements. 

a. descriptive c. impact 

b. dynamic d. required 
 

 



ANS: B PTS: 1 REF: EX 119 

 

 39. The Format Cells dialog box tab that provides options for locking or hiding cells to prevent other users 

from modifying their contents is _____. 

a. Alignment c. Protection 

b. Font d. Security 
 

 

ANS: C PTS: 1 REF: EX 93 

 

 40. The _____ command searches through the current worksheet or workbook for the content or 

formatting you want to locate. 

a. Seek c. Locate 

b. Find d. Search 
 

 

ANS: B PTS: 1 REF: EX 104 

 

Case Based Critical-Thinking Questions 

 

Case 2-1 

Harold has been working as a real estate agent. He has a lot of housing data to report and needs help 

organizing his data sheet for an effective presentation.  

 

 41. Harold has chosen green as the background color for his workbook. He should not use _____ for any 

of the font or highlight colors. 

a. red c. black 

b. white d. gray 
 

 

ANS: A PTS: 1 REF: EX 76 TOP: Critical Thinking 

 

 42. In one of Harold’s columns there are too many numbers after the decimal place. Harold does not need 

this level of detail. It is distracting from the data and he really only needs two numbers after the 

decimal. How could Harold make the data appear cleaner in the most efficient way? 

a. reenter all numbers and only enter two decimal places 

b. decrease the column width 

c. decrease the font size 

d. use the Number group to decrease number of digits displayed 
 

 

ANS: D PTS: 1 REF: EX 85 TOP: Critical Thinking 

 

 43. Harold cannot increase the width of his worksheet because, if he does, he will not be able to print it on 

one sheet. However, his columns are truncating his content. What solution would be the best for 

Harold to use to make all his text visible without losing data? 

a. abbreviate all text c. choose Wrap text for the columns 

b. change the font style d. delete one column 
 

 

ANS: C PTS: 1 REF: EX 87 TOP: Critical Thinking 

 

 44. Harold would like to center a title across the top of his data. His data runs across five columns, from 

column A to column E. One way he could accomplish this is to _____. 

a. type the data in A1 and Merge cells A1:A5 

b. type the data in A1 and Merge cells A1:E1 

c. type the data in C1 

d. type the data in any column in row 1 and then choose Center from the Format menu 
 

 

ANS: B PTS: 1 REF: EX 90 TOP: Critical Thinking 

 



 45. Harold needs to format several cells with 11pt Calibri font, two decimal places, right-aligned, and a 

blue font color. The most efficient way to accomplish this would be to _____. 

a. use Format Painter 

b. format each element using the Toolbar 

c. select all cells and use the Formatting dialog box 

d. apply a table style 
 

 

ANS: A PTS: 1 REF: EX 101 TOP: Critical Thinking 

 

 46. Harold wants to print ranges E6:F12 and E16:F22 of his worksheet. These are referred to as _____ cell 

ranges. 

a. selective c. consecutive 

b. nonadjacent d. specific 
 

 

ANS: B PTS: 1 REF: EX 115 TOP: Critical Thinking 

 

Case Based Critical Thinking Questions 

 

Case 2-2 
Antoinette is part of a college department creating a number of student files with Microsoft Excel. She  

is working on a student retention project and wants to produce a worksheet that can alert faculty of 

student progress and current grade status. 

 

 47. Antoinette wants all her worksheets to have the same formatting for text, colors, and graphical effects 

applied to create a specific look and feel. Antoinette needs to apply a _____. 

a. theme c. style 

b. template d. font 
 

 

ANS: A PTS: 1 REF: EX 70 TOP: Critical Thinking 

 

 48. Each worksheet will contain a specific class with the students’ grades for the entire term. In order to 

determine the current student grade, Antoinette would have to use the _____ function. 

a. SUM c. COUNT 

b. AVERAGE d. MEDIAN 
 

 

ANS: B PTS: 1 REF: EX 98 TOP: Critical Thinking 

 

 49. Antoinette’s workbook has all the data entered and students’ current grades displayed. She would like 

the current grade cells to display the value in red if it is less than 60. Antoinette needs to add _____ to 

the cell. 

a. cell formatting c. highlighting 

b. conditional formatting d. fill color 
 

 

ANS: B PTS: 1 REF: EX 108 TOP: Critical Thinking 

 

 50. When Antoinette shares her worksheet with other colleagues, she wants to ensure that everyone knows 

why certain cells are highlighted. To accomplish this, she will create a _____. 

a. journal c. legend 

b. documentation sheet d. formula sheet 
 

 

ANS: C PTS: 1 REF: EX 112 TOP: Critical Thinking 

 

 51. Antoinette wants to be sure that her worksheet does not contain any duplicates. She will use the 

highlight cells rule _____ to check for this. 

a. Equal to c. Duplicate Values 

b. Between d. A Date Occurring 
 



 

ANS: C PTS: 1 REF: EX 109 TOP: Critical Thinking 

 

 52. Because Antoinette is familiar with conditional formatting, she can use the _____, which provides 

access to the most common tools for data analysis and formatting. 

a. QuickTool Bar c. Quick Formatting Bar 

b. Quick Analysis Tool d. Conditional Analysis Tool 
 

 

ANS: B PTS: 1 REF: EX 110 TOP: Critical Thinking 

 
COMPLETION 

 

 1. ____________________ is the process of changing a workbook’s appearance by defining the fonts, 

styles, colors, and decorative features. 

 

ANS: Formatting 

 

PTS: 1 REF: EX 70 

 

 2. A(n) ____________________ is a collection of formatting that specifies the fonts, colors, and 

graphical effects used throughout the workbook.  

 

ANS: theme 

 

PTS: 1 REF: EX 70 

 

 3. Ten ____________________ colors—dark red, red, orange, yellow, light green, green, light blue, 

blue, dark blue, and purple—are always available regardless of the workbook’s theme.  

 

ANS: standard 

 

PTS: 1 REF: EX 73 

 

 4. Use the ____________________ button in the Alignment group on the Home tab to increase the size 

of the indention used in a cell. 

 

ANS: Increase Indent 

 

PTS: 1 REF: EX 87 

 

 5. One way to align text over several columns or rows is to ____________________, or combine, several 

cells into one cell. 

 

ANS: merge  

 

PTS: 1 REF: EX 90 

 

 6. The ____________________ tab in the Format Cells dialog box in Excel provides options for creating 

and applying background colors and patterns to cells.  

 

ANS: Fill 

 

PTS: 1 REF: EX 93 

 



 7. The ____________________ tab in the Format Cells dialog box in Excel provides options for how 

data is aligned within a cell.  

 

ANS: Alignment  

 

PTS: 1 REF: EX 92 

 

 8. The ____________________ copies the formatting from one cell or range to another cell or range 

without duplicating any of the data. 

 

ANS: Format Painter 

 

PTS: 1 REF: EX 101 

 

 9. A(n) ____________________ is a selection of formatting options using a specific font and color from 

the current theme. 

 

ANS: style 

 

PTS: 1 REF: EX 99 

 

 10. One of the benefits of conditional ____________________ is that it helps you analyze data by 

highlighting significant trends in data. 

 

ANS: formatting 

 

PTS: 1 REF: EX 109 

 

 11. To remove conditional formatting in Excel, click ____________________ after clicking the 

Conditional Formatting button. 

 

ANS: Clear Rules 

 

PTS: 1 REF: EX 112 

 

 12. A(n) ____________________ is a key that shows each color used in the worksheet and what it means.  

 

ANS: legend 

 

PTS: 1 REF: EX 112 

 

 13. The region that is sent to the printer from the active sheet is known as the ____________________.  

 

ANS: print area 

 

PTS: 1 REF: EX 115 

 

 14. A(n) ____________________ is text printed in the top margin of each page.  

 

ANS: header 

 

PTS: 1 REF: EX 119 

 



 15. When you specify a print area for a nonadjacent range, you are also inserting a(n) 

____________________ page break. 

 

ANS: manual 

 

PTS: 1 REF: EX 116 

 
ESSAY 

 

 1. Explain why it is important to use proper formatting, citing at least three benefits of a well-formatted 

workbook.  

 

ANS:  

Proper formatting is a balance between too little and too much formatting, both of which can make 

data hard to understand. A well-formatted workbook helps accentuate important trends and 

relationships in data. A well-formatted workbook can (1) be easier to read, (2) establish a sense of 

professionalism, (3) help draw attention to the points you want to make, and (4) provide continuity 

between worksheets. 

 

PTS: 1 REF: EX 70 TOP: Critical Thinking  

 

 2. Color allows you to effectively enhance a workbook, but could you ever use too much or “bad” color? 

Explain how or when color might detract from a workbook. Give at least four tips for effective color 

use. 

 

ANS:  

When used wisely, color can enhance any workbook. However, when used improperly, color can 

distract the user, making the workbook more difficult to read. As you format a workbook, keep in 

mind the following tips: 

 

Students should note at least four of the following tips: 

• Use colors from the same theme to maintain a consistent look and feel across the worksheets. If the 

built-in themes do not fit your needs, you can create a custom theme. 

• Use colors to differentiate types of cell content and to direct users where to enter data. For example, 

format a worksheet so that formula results appear in cells without a fill color and users enter data in 

cells with a light gray fill color. 

• Avoid color combinations that are difficult to read. 

• Print the workbook on both color and black-and-white printers to ensure that the printed copy is 

readable in both versions. 

• Understand your printer’s limitations and features. Colors that look good on your monitor might not 

look as good when printed. 

• Be sensitive to your audience. About 8 percent of all men and 0.5 percent of all women have some 

type of color blindness and might not be able to see the text when certain color combinations are used. 

Red-green color blindness is the most common, so avoid using red text on a green background or 

green text on a red background. 

 

PTS: 1 REF: EX 76 TOP: Critical Thinking  

 

 3. What is conditional formatting and why would you apply it? Give two examples of conditional 

formats, and explain a method for applying conditional formatting.  

 

ANS:  



Conditional formatting applies formatting only when a cell’s value meets a specified condition. A 

conditional format could make negative numbers red and positive numbers black. 

 

Excel has four conditional formats—data bars, highlighting, color scales, and icon sets. 

 

Students should explain one of the following two methods for applying conditional formatting. 

• Select the range or ranges to which you want to add data bars. 

• In the Styles group on the Home tab, click the Conditional Formatting button, point to Data Bars, and 

then click a data bar color. 

or 

• Select the range in which you want to highlight cells that match a specified rule. 

• In the Styles group, click the Conditional Formatting button, point to Highlight Cells Rules or 

Top/Bottom Rules, and then click the appropriate rule. 

• Select the appropriate options in the dialog box, and then click the OK button.  

 

PTS: 1 REF: EX 108 TOP: Critical Thinking  
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